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Electronic Claims Using the ANSI 837 Format – User Guide  

 

NPI Numbers –Billing and Rendering NPI numbers must be correct on your claims. If incomplete or incorrect 
provider/NPI numbers are entered on your claims, the claim will be rejected by the Payer.  

Please verify with the insurance company if you are unsure of your NPI and/or Provider/Group numbers for a 
specific payer.  https://nppes.cms.hhs.gov/  

 

Program Updates 
Before you begin to enter patient data check for updates to your program. To check for updates go to 
„Support/Help‟ on the EZClaim menu bar and select ‘Check for Updates’.  

 

https://nppes.cms.hhs.gov/
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ANSI 837 Quick Reference 
 

LOOP 2000A  (Specialty/Taxonomy) Segment EZClaim Location 

         Billing Provider Specialty Information PRV03 
Physician/Facility Library Icon>Billing or Rendering 
Provider >Taxonomy 

LOOP 2010AA  (Billing Provider)   

Billing Provider Name (Box 33) NM103 
Physician/Facility Library Icon>Billing Provider Name 
and Address 

Billing Provider Primary Identifier NM109 Physician/Facility Library Icon>Billing Provider>NPI 

Billing Provider Secondary Identifier REF02 
Physician/Facility Library Icon>Billing Provider >Tax 
ID# 

Billing Provider Secondary Identifier REF02 
Physician/Facility Library Icon>Billing Provider 
>Legacy ID# 

Billing Provider Address N3 & N4 
Physician/Facility Library Icon>Billing 
Provider>Address & Zip 

LOOP 2310B  (Rendering)   

Rendering Provider Name (Box 31) NM103 
Physician/Facility Library Icon>Rendering Provider 
First and Last Name 

Rendering Provider Primary Identifier NM109 
Physician/Facility Library Icon>Rendering 
Provider>NPI 

LOOP 2310A  (Referring)   

Referring Provider Name (Box 17) NM103 
Physician/Facility Library Icon>Referring Provider 
First and Last Name 

Referring Provider Primary Identifier NM109 
Physician/Facility Library Icon>Referring 
Provider>NPI 

LOOP 2310D (Facility)   

Service Facility Name (Box 32) NM103 Physician/Facility Library Icon> Facility Name 

Facility Address N3 & N4 
Physician/Facility Library Icon>Facility>Address & 
Zip 

Facility Primary ID# (If required) NM109 Physician/Facility Library Icon>Facility NPI 

LOOP 2010BB  (Payer)   

Payer (Insurance Co.) Name NM103 Payer Library Icon>Payer Name 

Payer ID# NM109 Payer Library Icon>Payer ID 

LOOP 2300     

Claim Information  
General claim information plus Diagnostic Codes and 
Total Claim Charge 

LOOP 2400   

Service Line Information (Charges tab)  
Data related to procedure code charges. Ex: Dates, 
procedure codes, modifiers, etc. 
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Sample Claim 

This CMS-1500 Sample claim is for a single provider. Practices with ‘Group’ 
numbers may require additional information. 

   

 

 

Confirm the Payer ID# 
has been entered in 
Payer Library.  

Date of Current – Usually 
required by Medicare. 
Situational for other 
Payers. 
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ANSI 837 Electronic Claims Data Entry 

 Note: Entering the following data will result in ANSI 837 errors! 

 Do not use words such as “Same” “None” or “N/A”. Use only valid data in fields.  

 Do not use MR., MS. or other prefixes. Do not use DR. MD, OD etc. A provider is identified by their NPI or 
Provider number. 

 Unless required by your insurance carriers do not use any special characters such as hyphens, commas, 
apostrophes, etc. or claims will reject. 

Submitter/Receiver Information – Step 1 
Options>Submitter Information 

 
Note: Go to http://www1.ezclaim.com/edi/payerlist.asp for information re a specific payer. 

1. Click on „Submitter/Receiver Library button‟ to open your Submitter/Receiver Library. 
2. Do not enter „Pay to Provider‟ unless required by your insurance company or claims will reject. 

 

 
 

3. To „Add‟ a new library entry, click on „New‟, enter all required data and then click on „Save‟. 
4. To „Edit‟ an entry, highlight the entry on the left, make changes and then click on „Save‟.  
5. When finished, click on „Save‟ and then „Close‟. 

  

 

http://www1.ezclaim.com/edi/payerlist.asp
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Required Fields 

 Library Entry Name - Enter a name to identify the library entry. 

 Export Format - Choose the export format from the drop down list.   

 Submitter Type - Use the drop down box to choose a Person or Non-Person type. 

 Submitter Name - Enter the name of the person or company submitting the file. 

 Submitter Identifier – Enter the EDI submitter number provided by the insurance carrier that identifies the 
submitter of the file. Contact your insurance carrier for your EDI submitter ID#. 

 Contact - Enter the name of the contact person.  

 Telephone Number - Enter the phone number of the contact person in this format, 5556667777. 

 Receiver Name - Information is provided by your insurance carrier. 

 Interchange Receiver ID (ISA08)- Information is provided by your insurance carrier. 

 Receiver ID (NM109) - Information is provided by your insurance carrier.  

 Test/Production Indicator - Enter either TEST or PROD. 

 Receiver Code (GS03) - Information is provided by your insurance carrier. 

Situational Fields 

NOTE: Do not enter Situational fields unless required by insurance carrier or errors will be generated! 

 ‘Strip extra characters from ID fields’ - Usually checked, uncheck only if the insurance company 
requires a dash in your Tax ID# for electronic claims. 

 Sender ID – Enter only if a different number than the Submitter ID number. 

 Sender Code – Enter only if different number than the Submitter ID number. 

 Password – Do not enter unless required by your insurance company for electronic claims. 

 Acknowledgment Requested -  Usually left checked. 

 Zip Export File – Usually left unchecked unless requested by your insurance company. 

Payer Library – Step 2 
 Payer Library Icon 

 
Note: This information must be entered before entering ‘Physician Library’ data. 
 

 

Add Payer Information to Library 

1. Enter name of Insurance carrier. 
2. Enter Payer ID# in „Payer ID‟ field.  
3.  Address is only required for paper claims.  
4. Using the dropdown arrow select „Ins. Type Code‟.  
5. Click on the‟ Save‟ button. 
6. Payer information is now listed in the box to the left.  

Edit Payer Information 

Highlight the Payer, edit Payer information and then click on the „Save‟ button. 
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Physician, Organization and Facility Library – Step 3 
Physician/Facility Library Icon 

 
Library information must be completed before entering patient data.  Once the entries are completed in the 
library, they will be selected on EZClaim data entry screens.  Correct set-up of the Library is important for error 
free claims. 

Classification 

The „Classification‟ determines in which selection list the name will appear.  For example, if you select „Billing‟, 
the name will only show in the Billing selection drop down (Box 33 on the 1500 form). 

Billing Provider Information (Box 33 on CMS 1500 form) 

 Enter the Name of Provider, Agency or Business Name. 
 

 
 

1. Classification, select „Billing‟. 
2. Type, select Person or Non-Person depending on the billing provider entry. 
3. Enter „Organization‟ name or „Last Name‟ and „First Name‟ if person.  
4. Enter Address information. 
5. Enter Individual or Organizational NPI number.  
6. Using the dropdown arrow, select „Tax ID Type‟ and enter number.  
7. Situational: Enter Taxonomy Code if required by your insurance company. 
8. Situational: ‘Additional ID Numbers‟.  Select Payer by clicking in the blank line. Continue entering ID Type 

and either the providers Individual or Group ID Number.  
Note: Fax and Email is used for your reference only. 

Click in blank line to bring 
up selection arrow. 

Use dropdown arrow to 
select Classification type 
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Rendering Provider Information (Box 24j on CMS 1500 form) 

If the Billing provider has obtained an Organizational NPI, the provider may also need a Rendering Provider entry 
for their Individual NPI/ Provider number. 

Enter First and Last name in „Full Name (Required)‟ field. 

 
 

1. Classification, select „Rendering‟. 
2. Type, select Person. 
3. Enter Last name and First name.  
4. Enter Individual NPI number.  
5. Optional: If Tax ID is required, enter under Additional ID Numbers.  
6. Click on „Save‟. 

Facility Information 

Note:  Usually only entered if the Billing information is different from the Facility information. 
1. Enter Facility Name in „Full Name (Required)‟ field. 
2. Classification, select „Facility‟. 
3. Type, select Non-Person. 
4. Enter Facility Name and Address information. 
5. Enter NPI number. 
6. Click on „Save‟. 

Referring Provider Information 

1. Enter First and Last name in „Full Name (Required)‟ field. 
2. Classification, select „Referring‟. 
3. Type, select Person. 
4. Enter Last name and First name. 
5. Enter NPI number. 
6. Click on „Save‟. 
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Patient/Insured Info Screen – Step 4 
 Do not use initials or credentials. MR., MS., DR., MD, INC. etc. 

 Do not use words such as „SAME‟ or „NONE‟ or „N/A‟. 

 NOTE: Refer to a CMS-1500 form for Box numbers.  
 

 

1a – Required - Enter Insured ID Number in this format, 222333444. Do not use dashes. 
Box 2 &5 - Enter Patient Information. (Once Patient Data is entered, you may use the „Copy Patient‟ button to 
copy data to right side of form.) 
Box 3 – Required - Enter Patient‟s Birth Date. 
Box 4 – Box Required - Enter Insured information.  
Box 6 – Required - „Patient Relationship to Insured‟. 
Box 9 a-d – Situational: Other Insured Information – Enter secondary data only if submitting a secondary 
insurance for this claim. Note: Enter secondary insured‟s ID# on the Payers/Other Info tab. 
Box 11 – Situational - Subscriber information is required if „Subscriber‟ is different than „Patient‟. 
Box 12 – Required - Check „Patient Signature on File‟. 
Box 13 – Situational - Check „Insured Signature on File‟ if you are requesting payment of this claim to be sent 
to the Provider. 
 
Note: Enter any additional information requested by the insurance company. 

Physician/Diagnostic Info Screen – Step 5 
 

 
 
Box 14 – Situational - Enter „Date of Current‟ which is the date of current illness, injury or pregnancy.  
Box 15 – Situational – Enter „First Date Of Similar Illness‟ if required by your insurance company. 
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Box 17 – Situational - Use dropdown to select Referring/Ordering Provider name and ID numbers previously 
set up in the Physician/Facility Library. (See ‟Physician/Facility Library‟ Icon)  
Claim Templates: Use dropdown to select a template for all claims for this patient. 

1. „Use Initial Charge Values‟ – Data entered into these fields will be used when clicking calendar dates 
on the Charges screen. 

2. „Use Previous Service Line‟ -  Service line data from last claim will be carried over to Charges screen. 
This data may then be edited on service line if necessary. 

3. „Use Previous Claim‟ - Service line and Diagnostic codes will be carried over to Charges screen. This 
data may be edited on Charges tab if necessary. 

Box 26 – Situational - Enter „Patient Account Number‟. You may use a number of your choice or go to 
Options>Data Entry General and check the box for „Automatically enter a Patient Acct. #‟. 
Box 27 – Required - Check „Accept Assignment‟ indicator. 
Box 31 – Required – Check „Signature on File‟ or select name of Rendering Provider if required. (Rendering 
Provider ID/NPI numbers will be entered into Box 24j.) 
 Note: DME Companies do not use Rendering Providers.  Leave the rendering provider field blank. 
Box 32 – Situational - Enter „Facility‟ information in Box 32 only if the Facility address is different than the 
Billing address in Box 33 unless required by your insurance company. 
Box 33 – Required - Using the dropdown arrow, enter Billing Provider Info & Phone # previously set up in the 
Physician/Facility Library.  

Payers and Others Info Screen – Step 6 
 

 

Primary/Destination Payer 

1. Click button to select „Primary/Destination Payer‟ previously set up in the Payer Library. 
2. Select by highlighting the Primary/Destination Payer and click „OK‟. 
3. Required: Using the dropdown arrow select „Primary Claim Filing Indicator‟.  
4. Note: See tabs below for additional Situational information. Do not enter „Situational‟ information unless 

required by our insurance company. 

Secondary/Other Payer 

1. Click on the „Click to Select Secondary/Other Payer‟ button. 
2. Required: Using the dropdown arrow select „Claim Filing Indicator‟.  
3. Required: Enter ID# of secondary insurance holder in „Secondary/Other Insured‟s‟ ID field. 
4. Enter „Patient Relationship to Insured‟ information. 
 

Note: To Delete a Payer on Payer/Others Info screen, click on the „Clear Primary‟ or „Clear Secondary‟ button. 

EDI Claim Notes: To include notes with your electronic file, check the „Include Notes with EDI‟ file checkbox. 
 

 



11 
 

 

New Charges Screen (Loop 2400) – Step 7 
Box 21 – Required - Diagnostic codes. 
Box 24A – Required - Click on the calendar to select „Date of Service‟. 
 

 
 

Enter charges and other service line information. 
Box 24B - Required - Place of Service: Must use 2 digits. 

11 - Office 
12 - Home 
21 - Inpatient Hospital 
22 - Outpatient Hospital 
23 - Emergency Room - Hospital 
24 - Ambulatory Surgical Center 
25 - Birthing Center 
26 - Military Treatment Facility 
31 - Skilled Nursing Facility 
32 - Nursing Facility 
33 - Custodial Care Facility 
34 - Hospice 
41 - Ambulance - Land 
42 - Ambulance - Air or Water 
51 - Inpatient Psychiatric Facility  
52 - Psychiatric Facility Partial Hospitalization 
53 - Community Mental Health Center  
54 - Intermediate Care Facility/Mentally Retarded 
55 - Residential Substance Abuse Treatment Facility 
56 - Psychiatric Residential Treatment Center 
61 – Comprehensive Inpatient Rehab Facility 
62 – Comprehensive Outpatient Rehab Facility 
71 – State or Local Public Health Clinic 
72 – Rural Health Clinic 
81 – Independent Laboratory 
99 – Other Unlisted Facility 

Box 24C – Situational – Enter EMG only if requested by your insurance company. Usually left blank. 
Box 24D – Required - Enter Procedure Code 
Box 24E - Required - Enter the diagnostic code line number (POINTER) on the charges line. Do not use the 
actual diagnosis code in this box, 24E, only pointers. Enter no more than four dx pointers on each service line.  
Box 24J – Situational This data is pulled from the Rendering Provider information which has been selected 
on the Physician/Diagnostic Info tab. If Rendering Provider information has not been selected on the 
Physician/ Diagnostic Info tab, use the dropdown arrow on the Charges tab to select Rendering Provider 
previously set up in the Physician/Facility Library. 
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NOTE: DME Companies do not use Rendering Providers.  Leave the rendering provider fields blank.  

DME, Ambulance and Chiropractic ANSI 837 Screens 
 

DME, Ambulance and Chiropractic screens require an extended features registration number. Contact EZClaim if 
you require one of these screens. 

 Ambulance 

 Chiropractic 

 DME/CMNs 
 

 

Ambulance Screen 

Ambulance Trip Information 
To enter information about an ambulance trip, open the ambulance information screen. 
Click on the Ambulance button. 

 

Enter codes into dialog box. 

 

Transport Codes: 
I  Initial Trip 
R  Return Trip 
T  Transfer Trip 
X  Round Trip 
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Transport Reason Codes: 
A   Patient was transported to nearest facility for care of symptoms, complaints, or both. 
B   Patient was transported for the benefit of a preferred physician. 
C   Patient was transported for the nearness of family members. 

Condition Indicators: 
01  Patient was admitted to a hospital 
02  Patient was bed confined before the ambulance service 
03  Patient was bed confined after the ambulance service 
04  Patient was moved by stretcher 
05  Patient was unconscious or in shock 
06  Patient was transported in an emergency situation 
07  Patient had to be physically restrained 
08  Patient had visible hemorrhaging 
09  Ambulance service was medically necessary 
60  Transportation Was To the Nearest Facility 

Round Trip Purpose Description 
A free form description to clarify the purpose for the round trip ambulance service. 

Stretcher Purpose Description 
A free form description to clarify the purpose for the usage of a stretcher during ambulance service. 

Box 32 (CMS 1500) 
If printing paper claims, information for Box 32 on the CMS-1500 can be entered into this field to facilitate 
pickup location information without having to enter data into the Physician/Facility library. 

Chiropractic Screen 

Click on the Chiropractic button. 

 

Enter codes necessary to supply information related to the chiropractic service rendered to a patient. 

 

Click the „Copy Previous Values‟ button to copy the values from the previous claim for this patient. 

Treatment Number – CR2 01 
The number this treatment is in the series. 

Total Number of Treatments in this Series – CR2 02 
Enter number. 

Number of Treatments this Month – CR2 07 
The number of treatments rendered in the month of service. 
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Time Period for this Series – CR2 06 
The time period involved in the treatment series. 

Units – CR2 05 
Use dropdown to select the number of units. 

Subluxation Level Codes – CR2 03/04 
The beginning and ending level of subluxation.  

C1 Cervical 1 
C2 Cervical 2 
C3 Cervical 3 
C4 Cervical 4 
C5 Cervical 5 
C6 Cervical 6 
C7 Cervical 7 
CO Coccyx 
IL Ilium 
L1 Lumbar 1 
L2 Lumbar 2 
L3 Lumbar 3 
L4 Lumbar 4 
L5 Lumbar 5 
OC Occiput 
SA Sacrum 
T1 Thoracic 1 
T10 Thoracic 10 
T11 Thoracic 11 
T12 Thoracic 12 
T2 Thoracic 2 
T3 Thoracic 3 
T4 Thoracic 4 
T5 Thoracic 5 
T6 Thoracic 6 
T7 Thoracic 7 
T8 Thoracic 8 
T9 Thoracic 9 

Acute Manifestation Date 
This date is exported into the DTP*453 segment in loop 2300 of the ANSI 837 file. 

Nature of Condition – CR2 08 
Code indication the nature of a patient‟s condition. 

A Acute Condition 
C Chronic Condition 
D Non-acute 
E Non-Life Threatening 
F Routine 
G Symptomatic 
M Acute Manifestation of a Chronic Condition 

Complication Indicator – CR2 09 
A “Y” value indicates a complicated condition; an “N” value indicates an uncomplicated condition. 

X-Rays Available – CR2 12 
A “Y” value indicates X-rays are maintained and available for carrier review; an “N” value indicates X-rays are 
not maintained and available for carrier review. 

Patient Condition Description 1 & 2 – CR2 11/11 
This is a free form description to clarify the related data elements and their content.  Limit to 80 characters per 
field. 
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DME/CMN Screen 

When sending claims to one of the 4 DMERC regions, it may be necessary to attach electronic CMNs to 
service/product line items.  EZClaim allows a user to attach a CMN to the „claim‟ and the CMN will be attached 
ONLY to line items that have a check in the CMN box. 

 

When entering a new claim, EZClaim will remind you to attach a CMN if the CMN box is checked but no CMN 
has been attached. 

Copying Previous CMNs 
If you check the CMN box on a service line and a CMN is not currently „attached‟ to this claim, EZClaim will 
prompt to copy the previous CMN to this claim.  This prevents having to enter the CMN information again. 

Attaching a CMN to a Claim 
Click on the „Attach CMN‟ screen. 

 

 
 

Select by highlighting the CMN for this claim and click the OK button.  

 
 

Enter Data into the CMN screen.  The CMN screens represent Section B of the CMN.  Please note the 
Length of Need, Initial Date, and Signed Date are all required fields.  EZClaim will not let you close the CMN 

screen until those fields are entered. 
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Printing CMNs 

How do I print CMNs? 

Once service lines have been entered onto a claim, you can print a CMN.  Click the „Attach CMN Form‟ or the 
button labeled with the CMN name (i.e. „Hospital Beds CMN‟).  There will be a „Print‟ button available to print 
the CMN.  The CMN printed will contain both sides of the CMN form. 

Section A – Patient Name – Data is pulled from the Patient information on the left hand side of the 
Patient/Insured Info screen (Box 1a, 2, and 5 on the CMS-1500). 

Section A – Supplier Name – Data is pulled from the Physician/Supplier information on the bottom left of the 
Physician/Diagnostic Info screen (Box 33 on the CMS-1500). 

Section A – Place of Service – Data is pulled from the first service line‟s place of service value. 

Section A – HCPCS Codes – Data is pulled from the CPT/HCPCS column on the charges screen.  
IMPORTANT: Only HCPCS codes from service lines that have the „CMN‟ box checked will print in this area. 

Section A – Patient DOB, etc – Patient DOB, and Sex is pulled from the patient info on the Patient/Insured Info 
screen.  Height and Weight is pulled from the Patient Height and Patient Weight fields on the Payers/Other 
Info screen. 

Section A – Physician Name and UPIN – Data is pulled from the Referring/Ordering drop down box on the 
Physician/Diagnostic Info screen, the UPIN from the „ID of Referring Physician‟ field.  The address and phone 
number are pulled from the physician‟s entry in the Physician Library. 

Note: – Narrative – Other information may be printed depending on CMN selected and information required. 
Up to 10 service lines of information can be printed.  The CPT/HCPCS and Units information is pulled from the 
service lines.  The Description, Charges, and Allowed Amounts are pulled from the Procedure Code Library. 
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Exporting Claims 
Electronic Claims! Icon the Menu bar 

 

Once the patient and claim data has been entered into the EZClaim program you are now ready to generate 
your file for electronic transmission.  

Submitter/Receiver Data Entry 
1. Go to „Electronic Claims‟ 
2. Using the dropdown select the file „Format' being submitted. Ex: For all ANSI files the ANSI 837 would be 

selected.  
3. Using the dropdown, open the Submitter/Receiver Library window. 
4. Select the correct Submitter/Receiver information for the file being submitted. 
Note: Clicking on the  button to the right will open the full Library. 
 

 

Exporting Claims 

1. Select claims to be exported by checking the check box next to claim.  Note: You may also click the 
„Check All‟ box if all claims are ready to submit. 

2. Once claims have been selected, click on the „Check for Errors‟ button to analyze the file before submitting 
to the insurance carrier. If errors are found, return to patient record and update data.  
 

 
 

6. To view the full analyzed file hold down the Ctrl key and click the Check for Errors button. 
7. Return to „Electronic Claims‟ dialog box and click on the ‟Export (Create Batch and Send) button.  
8. In the „Save As‟ dialog box, click the „Save In‟ dropdown arrow and select „Desktop‟ or a location of your 

choice. 
9. By default, file name will be „Claimdat‟. The file name „Claimdat‟ should be changed for each submission. 

Some providers use a Filename based on the date of submission. EX: 010111.txt.  
 

IMPORTANT: If your payer uses a specific file location and file name, follow the payer‟s instructions. 
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10. Click on the „Save‟ button. Please note the full Path and Filename of your batch file. 
 

 
 

11. If you would like a printed Submission report, click „Yes‟ to print report. (Submission Reports are saved 
and may be accessed by going to File on the menu bar>Reports>Submission Reports.) 

12. In the „Send Exported Claims‟ dialog box, enter transmission telephone number or Web page address if 
submitting over the Web and click „Go‟. 

  
 

13. If you entered a telephone number, once connected follow payer‟s instructions for entering Logon ID and 
Password. (Below is a sample „Bulletin Board‟ system. Your Payer may use a different system.) 

  
 

14. When asked to „Send‟ file, click on „Send File‟ on the menu bar of the Terminal program. 
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15. Using dropdown arrow select Modem protocol for transmission.  We suggest using ZModem protocol for 
uploading files. (Check your Payer‟s Bulletin Board instructions for modem requirements.) 
 

 
 

16. In „Send File‟ dialog box enter „Filename‟ by right clicking in the box and selecting „Paste‟, or click on  to 
browse and select your file. 

17. Click „Send‟. 
18. Follow payer‟s remaining instructions. 

Re-Exporting Claim Data 
Selecting Previously Submitted Claims 

Click on the „Show Previous Batch‟ button. 
 

 
 

1. Double click on the previous batch of claims to view. 
 

 
 
2. Select by clicking the check box(s) or use the „Check All‟ button. 
3. Click on the „Export (Create Batch)‟ or „Export (Create Batch and Send)‟ button. 
4. Re-export claims. 
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Terminal - Retrieving Reports 
Menu Location: File > Terminal Program 

 
Note:  If your insurance company (Payer) uses a Bulletin Board system, follow these instructions.  For all 
other submission methods follow the instructions for that Payer. 

 

Use EZTerminal to dial into the Payer‟s computer. Once connected you can access all the features of the 
Payer‟s Bulletin Board System. (BBS) 

Using the EZTerminal Send File Feature 
 
1. Go to File on the menu bar, select „Terminal Program‟. 
2. Confirm the correct phone number and modem by clicking on „Setup‟. 
3. Click on „Connect‟. 
4. Once connected use features of Payer‟s BBS to navigate screens. 
5. When sending file, click „Send File‟ on menu bar and enter the Filename by right clicking and choosing 

„Paste‟. Select Protocol. Use ZModem or choose alternate protocol by clicking on dropdown arrow. 
6. When finished click the „Hang Up‟ button 

Using the EZTerminal Receive File Feature 
The following are general instructions for retrieving response files. Your Bulletin Board System (BBS) may 
have different requirements. 

Tip: When viewing the list of files to download on the BBS, use EZTerminal‟s „Print Screen‟ menu item to print 
the page of filenames.  This helps if searching for the downloaded file. 

Log into BBS using the carrier‟s BBS instructions 
1. Navigate to the download section. 
2. At some point you may be asked to select a protocol.  We suggest using ZModem  

 

 
 

3. Select the file to download. (If there are additional files, you may have to repeat process) 
4. Click the „Receive File‟ item on the EZTerminal menu bar.  A receive box will appear. 
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5. Use the „Browse‟ button to choose the location for saving the file, we suggest saving files to the Desktop 
for easy retrieval. 

6. Select ZModem  
7. Click on the 'Receive File' button. 
8. When asked if you would like to Analyze file select ‘YES’.  NOTE: If you are using Hyper Terminal or 

Web based submission you must use the EZClaim Analyzer to analyze your reports.  Go to the 
downloaded file, right click on the file, select „Send To‟ and then „EDI Analyzer‟. 

9. Print error report. 
10. If windows opens a box asking which program to use when opening the file, scroll down and choose 

'WordPad' or „Notepad‟ 
 

 
 


